LENESAS

Release Note

RZ/T2H Group

Dual Encoder sample program

Summary

This document describes the RZ/T2H Dual Encoder sample program package.

For A-format™ Ver.2.0 communication protocol specifications and encoder specifications (RES-61QAP06),

contact Nikon Corporation.

For EnDat 2.2 communication protocol specifications and encoder specifications (EQN1035), contact

HEIDENHAIN GmbH.

Functionality Checked Device
RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)
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RZ/T2H Group Dual Encoder sample program

1. Package Contents

This package contains the following contents.

The RZ/T2H encoder interface supports up to 16 axes, but the sample program uses a total of 2 axis, with
one axis using A-format and one axis using EnDat. If you use with 3 axes or more simultaneously, modify the
sample program to support required axes.

This sample program operation was checked with one-to-one connection A-format Ver.2.0 encoder.
Operation with bus connection encoder is not checked. Operation with A-format Ver.1.0 encoder is not

supported.

1.1 Software
e Source code

No. Name Version number
1 RZ/T2H Dual Encoder sample program (CR52 ver.*) 2.0
2 RZ/T2H Dual Encoder sample program (CA55 ver.*) 20

Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Documents

No. Document name Version File name
1 RZ/T2H Group Dual Encoder 2.00 (j) r11an0990jj0200-rzt2h.pdf
sample program Release Note (e) r11an0990ej0200-rzt2h.pdf (this document)
2 RZ/T2H Group Dual Encoder 2.00 (j) r11an0989jj0200-rzt2h-dual.pdf
sample program Application (e) r11an0989ej0200-rzt2h-dual.pdf
Note
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Dual Encoder sample program

2. File Structure

The file structure and contents of this package are detailed below.

Top
F— r11an0990jj0200-rzt2h.pdf
— r11an0990ej0200-rzt2h.pdf
L— workspace
— Software
| —iccarm
| — RZ_T2H_CR52_dual.zip
|
L RZ_T2H_CA55_dual.zip
— RZ_T2H_CA55_0_dual
|
L—RZ_T2H_CR52_0_primary

— RZ_T2H_CR52_dual.zip

|

L— RZ_T2H_CAS55_dual.zip
— RZ_T2H_CA55_0_dual
|

|
.
I
(.
|
|
| —gcc
|
|
|
|
|
| L— RZ_T2H_CR52_0_primary
L— Documents
— r11an0989jj0200-rzt2h-dual.pdf

— r11an0989¢j0200-rzt2h-dual.pdf

: RZ/T2H Dual Encoder sample program set

CR52 ver. (IAR)

: RZ/T2H Dual Encoder sample program set

CAS55 ver. (IAR)

: CPU_CTRL register setting program (IAR)

: RZ/T2H Dual Encoder sample program set

CR52 ver. (e? studio)

: RZ/T2H Dual Encoder sample program set

CAS55 ver. (e? studio)

: CPU_CTRL register setting program (e? studio)

R11ANO990EJ0200 Rev.2.00
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RZ/T2H Group Dual Encoder sample program

The file structure of the RZ_T2H_CR52_dual.zip and RZ_T2H_CA55 0_dual folder is shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Build Tool Dependent Environment File )
L—src
— hal_entry.c : Dual Encoder sample program
F— dual_main.c : Dual Encoder sample program
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L—drv
—a_as
| — iodefine_a_as.h : A_AS register definition file
| F—r_a_as rzt2.c : A_AS driver file
| F—r_a_as_rzt2_config.h : A_AS driver file
| F—r_a_as_rzt2_dat.h : A_AS driver file
| F—r_a_as_rzt2_if.h : A_AS driver file
| F—r_a_as_rzt2_private.h : A_AS driver file
| L— a_format
| F—r_a_format_rzt2.c : A-format driver file
| —r_a_format_rzt2_config.h  : A-format driver file
| L—r_a_format_rzt2_private.h : A-format driver file
— endat
— iodefine_endat.h : EnDat register definition file
—r_endat_rzt2.c : EnDat driver file
F—r_endat_rzt2_config.h : EnDat driver file
F—r_endat_rzt2_dat.h : EnDat driver file
L—r_endat_rzt2_if.h : EnDat driver file

The file structure of the RZ_T2H_CR52_0_primary is shown below.
Top folder
— configuration.xml : FSP Configuration data

I ( Build Tool Dependent Environment File )
—src

L— hal_entry.c : CA55 start-up program
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Dual Encoder sample program

3. About Dual Encoder Sample Program

This section contains information necessary to use the complete set of Dual Encoder sample program.

3.1

3.1.

Software Information

1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program, A-format driver and EnDat driver is shown in following table.
This table does not include memory size used by Flexible Software Package or C language libraries of the

compiler.
(1) CR52 ver.
ltems Memory Size
EWARM e? studio
[kBytes] [kBytes]
A-format driver Code 4.0 3.3
Data (with initial value) 0.0 0.0
Data (without initial value) 6.1 6.1
Constant Data 0.2 0.2
EnDat driver Code 4.2 3.1
Data (with initial value) 0.0 0.0
Data (without initial value) 0.8 0.8
Constant Data 0.2 0.2
Sample program Code 6.5 7.2
Data (with initial value) 0.1 0.0
Data (without initial value) 0.9 0.9
Constant Data 3.1 3.1
(2) CADb55 ver.
ltems Memory Size
EWARM e? studio
[kBytes] [kBytes]
A-format driver Code 5.7 5.5
Data (with initial value) 0.0 0.0
Data (without initial value) 6.7 6.8
Constant Data 0.3 0.3
EnDat driver Code 6.1 4.9
Data (with initial value) 0.0 0.0
Data (without initial value) 1.0 1.0
Constant Data 0.3 0.3
Sample program Code 9.9 12.7
Data (with initial value) 0.2 0.0
Data (without initial value) 0.9 1.0
Constant Data 3.4 3.5
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RZ/T2H Group

Dual Encoder sample program

3.2 Hardware Information
3.2.1 Device
RZ/T2H

3.2.2 Target Board
(1) Board Name

RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)

(2) Setting of Target Board
The target board configuration is as follows.
SW1-4: ON
SW1-6: OFF
SW2-1: ON, SW2-2: OFF
SW2-7: OFF
SW2-8: OFF

SW14-1: ON, SW14-2: OFF, SW14-3: ON, SW14-6: OFF (Set xSPI1 boot mode)

CN39: Short between 2-3 pins (Set VDD1833_2 to 3.3 V)
CN40: Short between 2-3 pins (Set VDD1833_3 to 3.3 V)

CN78: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3 V)

Note: To use Target board RTKORZT2HOCW1000BJ with connecting RS-485 board, power on/off by
plugging and unplugging to the power-supply connector CN47 with keeping the slide switch SW16 on.

R11ANO990EJ0200 Rev.2.00
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(3) Used Pin for Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as

follows.
Channel Pin Name Pin Input/ Voltage Description
Header Output Domain

AFMTO / ENDAT_CHO ENCIFCKO0 *2 | CN2 #3 Output VDD33 Clock output
ENCIFOEOO CN2 #5 Output VDD33 Data output enable
ENCIFDOO00 CN2 #7 Output VDD33 Data output
ENCIFDIOO CN2 #9 Input VDD33 Data input

AFMT1 / ENDAT_CH1 ENCIFCKO1 *2 | CN2 #2 Output VDD1833_3 | Clock output
ENCIFOEO1 CN2 #4 Output VDD1833 3 | Data output enable
ENCIFDOO01 CN2 #6 Output VDD1833_3 | Data output
ENCIFDIO1 CN2 #8 Input VDD1833_3 | Data input

AFMT2 / ENDAT_CH2 *1 ENCIFCKO02 *2 | CN2 #11 Output VDD33 Clock output
ENCIFOEO02 CN2#13 | Output VDD33 Data output enable
ENCIFDO02 CN2 #15 | Output VDD33 Data output
ENCIFDIO2 CN2 #17 | Input VDD33 Data input

AFMT3 / ENDAT_CH3 *1 ENCIFCKO03 *2 | CN2 #12 | Output VDD33 Clock output
ENCIFOEO03 CN2#14 | Output VDD33 Data output enable
ENCIFDOO03 CN2 #16 | Output VDD33 Data output
ENCIFDIO3 CN2 #18 | Input VDD33 Data input

AFMT4 / ENDAT_CH4 * ENCIFCKO4 *2 | CN2 #21 Output VDD33 Clock output
ENCIFOE04 CN2 #23 | Output VDD33 Data output enable
ENCIFDO04 CN2 #25 | Output VDD1833_5 | Data output
ENCIFDIO4 CN2 #27 | Input VDD1833_5 | Data input

AFMT5 / ENDAT_CH5 *1 ENCIFCKO5 *2 | CN2 #20 | Output VDD1833_6 | Clock output
ENCIFOEQ5 CN2 #22 | Output VDD1833 6 | Data output enable
ENCIFDO05 CN2 #24 | Output VDD1833_6 | Data output
ENCIFDIO5 CN2 #26 | Input VDD1833_6 | Data input

AFMT6 / ENDAT_CHG6 *! ENCIFCKO06 *2 | CN3 #3 Output VDD1833_3 | Clock output
ENCIFOEO6 CN3 #5 Output VDD1833_3 | Data output enable
ENCIFDOO06 CN3 #7 Output VDD1833_3 | Data output
ENCIFDIO6 CN3 #9 Input VDD1833_3 | Data input

AFMT7 / ENDAT_CH7 *! ENCIFCKO7 *2 | CN3 #2 Output VDD1833_3 | Clock output
ENCIFOEQ7 CN3 #4 Output VDD1833 3 | Data output enable
ENCIFDOO07 CN3 #6 Output VDD1833_3 | Data output
ENCIFDIO7 CN3 #8 Input VDD1833_3 | Data input

AFMTS8 / ENDAT_CH8 *1 ENCIFCKO08 *2 | CN3 #11 Output VDD33 Clock output
ENCIFOEO08 CN3#13 | Output VDD33 Data output enable
ENCIFDOO08 CN3 #15 | Output VDD33 Data output
ENCIFDIO8 CN3 #17 | Input VDD33 Data input

AFMT9 / ENDAT_CH9 *1 ENCIFCK09 *2 | CN3 #12 | Output VDD1833_2 | Clock output
ENCIFOEO09 CN3#14 | Output VDD1833_2 | Data output enable
ENCIFDO09 CN3 #16 | Output VDD1833 2 | Data output
ENCIFDIO9 CN3 #18 | Input VDD1833_2 | Data input

AFMT10 / ENDAT_CH10 *' | ENCIFCK10 *2 | CN3 #21 Output VDD1833_2 | Clock output
ENCIFOE10 CN3#23 | Output VDD1833_2 | Data output enable
ENCIFDO10 CN3 #25 | Output VDD1833_2 | Data output
ENCIFDI10 CN3 #27 | Input VDD1833_2 | Data input
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Channel Pin Name Pin Input/ Voltage Description
Header Output Domain
AFMT11/ENDAT_CH11 *' | ENCIFCK11 *2 | CN3 #20 | Output VDD1833_2 | Clock output
ENCIFOE11 CN3 #22 | Output VDD1833_2 | Data output enable
ENCIFDO11 CN3 #24 | Output VDD1833_2 | Data output
ENCIFDI11 CN3 #26 | Input VDD1833_2 | Data input
AFMT12 / ENDAT_CH12 *' | ENCIFCK12 *2 | CN10 #3 | Output VDD1833_6 | Clock output
ENCIFOE12 CN10#5 | Output VDD1833_6 | Data output enable
ENCIFDO12 CN10 #7 | Output VDD1833_6 | Data output
ENCIFDI12 CN10#9 | Input VDD1833_6 | Data input
AFMT13 / ENDAT_CH13 *' | ENCIFCK13 *2 | CN10 #2 | Output VDD1833_6 | Clock output
ENCIFOE13 CN10#4 | Output VDD1833_6 | Data output enable
ENCIFDO13 CN10 #6 | Output VDD1833 6 | Data output
ENCIFDI13 CN10 #8 | Input VDD1833_6 | Data input
AFMT14 / ENDAT_CH14 *' | ENCIFCK14 *2 | CN10 #11 | Output VDD33 Clock output
ENCIFOE14 CN10 #13 | Output VDD33 Data output enable
ENCIFDO14 CN10 #15 | Output VDD33 Data output
ENCIFDI14 CN10 #17 | Input VDD33 Data input
AFMT15/ ENDAT_CH15*! | ENCIFCK15*2 | CN10 #12 | Output VDD33 Clock output
ENCIFOE15 CN10 #14 | Output VDD33 Data output enable
ENCIFDO15 CN10 #16 | Output VDD33 Data output
ENCIFDI15 CN10 #18 | Input VDD33 Data input

Note 1. The pins are not used in the initial channel configuration. When the channel used is changed, the
corresponding pin header is used.
Note 2. In A-format, the clock pin ENCIFCK is not used.
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3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Order of transmission / reception LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H_ N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CR52_dual.zip and copy the extracted source files to the desired location.
Activate EWARM.

2
3 Select [File] menu -> [Open Workspace].

4 Open the extracted source file RZ_T2H_dual.eww.

5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.
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RZ/T2H Group Dual Encoder sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

[FG C:¥1_Prog¥Work¥Work_C¥Work_EWA_960_2_fsp2.2.0¥RZT2H_Dual_release_chk - FSP Smart Configurator

(m] X
File Window Run Help
RZT2H_Dual_release_chk] FSP Configuration X e “7 FSP Visualization =0
)
»
Summary Generate Project Content 2]
Project Summary ; A
RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: RIA09GO77M44GBG
Core: CR52 CPUO

FSP Version: 22.0
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_960_2_fsp2.2.0/RZT2H_Dual_release_chk <

Selected software components

Board Support Package Common Files V220
Memory Config Checking V220
/0 Port V220 vV [eeesss
Summary | BSP| Clocks| Pins | Interrupts | Event Links | Stacks | Components > A8
[ Properties [2 Problems %28 =0 B console *HB~r=8

No consoles to display at this time.

Properties are not available.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2H_dual.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.15.10 console commands in the RZ/T2H Group Dual Encoder Sample Program Application Note.

¥ COME - Tera Term VT - O X

File Edit Setup Control Window Help
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RZ/T2H Group Dual Encoder sample program

3.3.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version: GNU ARM Embedded 12.2.1.arm-12-24
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_ CR52_dual.zip and copy the extracted source files to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

& Dual release_chk - e? studio — O X
File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help
[ ® K]~ wity v Q- Q B Ecc+
5 Project Explorer X = a8 = 8 | 5% outline < = 0|g
SR-DVA There is no active editor | @)
v I RZ_T2H _dual [Debug] that provides an outline.

[n Includes
Rcl

& configuration.xm|
=| RZ_T2H_dual Debug_Flatjlii
X| RZ_T2H_dual Debug_Flatlai

(?) Developer Assistance

I*. Problems X | & Console ] Properties @ Smart Browser | ) Smart Manual 7 § = a8
0 errors, 12 warnings, 0 others
Description - Resource Path Location Type

) Warnings (12 items)

< > < >

ﬁ;? configuration.xml - RZ_T2H_dual
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6 Click Generate Project Content in the FSP Configuration pane of e2 studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated.

) Dual_release_chk - RZ_T2H_dual/configuration.xml - ¥ studio — u] %
File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help
G- & - o ity v Q- Q Q| BEccs
3 Project Explorer =0 [RZ_T2H_dual] FSP Configuration — ] =g
= (V] There is no active editor that id
at provides an
v g% RZ_T2H _dual Summary Generate Project Content outline.
nll' Includes "
. Project Summal
oo g i RENESAS
2 configurationxml
- Board: RZT2H Evaluation Board (RAM execution without flash memory)
RZ_T2H_dual Debug_Flatjlink .
%] RZ_T2H_dual Debug_Flat laun Device: RIADICOTTMAAGEE
5 . Core: CR52 CPUO
Developer Assistance N
Toolchain: GCC for Renesas RZ
Toolchain Version: 12.2.1.arm-12-24
FSP Version: 220
Project Type: Flat
Location: C:/1_ProgWork/Work_C/Work E2S_RZ....2.0/Dual_release_chk/RZ_T2H_dual &=
Selected software components
Board Support Package Common Files v2.20
Memory Config Checking v2.20
1/0 Port v2.2.0 hd
Summary | BSP| Clocks| Pins Interrupts| Event Links| Stacks Companents
. Problems < | B Console [Tl Properties| @ Smart Browser L5 Smart Manual =g
0 errars, 12 warnings, 0 others
Description Resource Path Location Type
& Wamings (12 items)
< >
configurationxm| - RZ_T2H_dual

7 Select [Project] menu -> [Build All]
The Debug\RZ_T2H_dual.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2  Click [Debug] to start downloading to internal RAM.
3  Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.15.10 console commands in the RZ/T2H Group Dual Encoder Sample Program Application Note.

VTl COMG - Tera Term VT - ] X
File Edit Setup Control Window Help
) tart -
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3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Order of transmission / reception LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CA55_dual.zip and copy the extracted source files to the desired location.
Activate EWARM.

Select [File] menu -> [Open Workspace].

Open the extracted source file RZ_T2H_CR52_0_primary -> RZ_T2H_CR52_0_primary.eww.
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b~ wWwN

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.
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6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

[EG C:¥1_Prog¥Work¥Work_C¥Work EWA_960_2_fsp2.2.0¥RZT2H_Dual_CASS5 release_chk¥RZ_T2H_CR52_0_primary - FSP Smart Configurator

[m] X
File Window Run Help
5% [RZ_T2H_CRS52_0_primary] FSP Configuration X ammn 5 FSP Visual =0
[>) 5|2
»
Summary Generate Project Content L2 L L
Project Summary A
RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: RYA09G077M44GBG
Core: CR52 CPUO

FSP Version: 2.2.0
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_96...release_chk/RZ_T2H_CR52_0_primary x|

Selected software components

Board Support Package Common Files v2.2.0
Memory Config Checking v2.2.0
1/O Port v22.0 M
E Support @
‘Summary | BSP| Clocks | Pins | Interrupts | Event Links| Stacks | Components > Al
[ Properties [2 Problems 8§ =08 B consle ~-B-=08

No consoles to display at this time.

Properties are not available

7 When project generation is complete, close the Smart Configurator.

8 Select [Rebuild ALL] from the [Project] menu of EWARM.

The file Debug\Exe\RZ_T2H_CR52_0_primary.sbd is generated.

9 Select [File] menu -> [Open Workspace].

10 Open the extracted source file RZ_T2H_CA55 0 dual — RZ T2H CA55 0 dual.eww.
(RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this workspace file.
Please build the primary project in advance.)

11 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE.

12 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

[FG C:¥1_Prog¥Work¥Work C¥Work EWA_960_2_fsp2.2.0¥RZT2H_Dual CASS_release_chk¥RZ_T2H_CAS55_0_dual - FSP Smart Configurator - u] X
File Window Run Help

8} [RZ_T2H_CAS55_0_dual] FSP Configuration X e 5 FSP Vi =8
[>)
Summary Generate Project Content Lol LT >
Project Summary A
RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: RYA09G077M44GBG
Core: CA55 Core0

FSP Version: 2.2.0
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_96...55_release_chk/RZ_T2H_CA55_0_dual ==

Selected software components

Board Support Package Common Files v2.2.0
Memory Config Checking v2.2.0
1/0 Port v2.2.0 M
E SUBROLY . =
_Summary | BSP| Clocks | Pins | Interrupts| Event Links| Stacks| Components > ABl
[ Properties [21 Problems 8§ =08 Bconsol ~HMy=0

No consoles to display at this time.

Properties are not available

13 When project generation is complete, close the Smart Configurator.
14 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\ RZ_T2H_ CA55 0_dual.out is generated.

R11AN0990EJ0200 Rev.2.00 Page 14 of 19



RZ/T2H Group Dual Encoder sample program

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Inthe workspace of RZ_T2H_CR52_0_primary, select [Project] menu -> [Download and Debug].
RZ_T2H_CA55_0_dual project is launched.

2 Inthe workspace of RZ_T2H_CR52_0_primary, select [Debug] menu -> [Execute]. CA55 start-up
program is executed.

3 In the workspace of RZ_T2H_CA55 0_dual, select [Debug] menu -> [Execute]. Sample program is
executed.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.15.10 console commands in the RZ/T2H Group Dual Encoder Sample Program Application Note.

¥T| COME - Tera Term VT - O X

File Edit Setup Control Window Help
start

3.4.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version:
GNU ARM Embedded 12.2.1.arm-12-24 (Used by RZ_T2H_CR52_0_primary.)
GCC ARM A-Profile (Aarch64 bare-metal) 10.3.1.20210621 (Used by RZ_T2H_CA55_0_dual.)
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_ CA55_dual.zip and copy the extracted source files to the desired location.
2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].

R11AN0990EJ0200 Rev.2.00 Page 15 of 19
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3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml of the RZ_T2H_CR52_0_primary project in the Project Explorer
pane of e? studio to open it.

w Dual_CA55_release_chk - e? studio — O X
File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help
|® -]~ wifs v Qv Q % |Eoc
5 Project Explorer X = 8 = O | g Outline X = 8|a
2% Y § There is no active editor that €8
v ‘fg RZ_T2H_CA55_0_dual provides an outline.
(5 Includes
(B sre

& configuration.xm!
=| RZ_T2H_CA55_0_dual Debug_Fle
|¥] RZ_T2H_CA55_0_dual Debug_Fle
@ Developer Assistance
v ‘fg RZ_T2H_CR52_0_primary [Debug]
(5 Includes

i:—i’ configuration.xm|

I#1 Problems X | B Console| [Z] Properties| @ Smart Browser | 1) Smart Manual 7 § = 0O
= A _0_primary Debug 0 errors, 24 warnings, 0 others
] RZ_T2H_CR52.0_primary Debug Description Resource Path Location Type
@ Developer Assistance i, Warnings (24 items)
< > | ¢ >

{F:? configuration.xm| - RZ T2H_CR52_0_primary

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated in the RZ_T2H_CR52_0_primary

Q Dual_CASS5 _release_chk - RZ_T2H_CR52_0_primary/cenfiguration.xml - e? studio - a X ‘
File Edit Source Refactor Mavigate Search Project RenesasViews Run Window Help
-4~ wits v Q- Q iE| R
(3 Project Explorer = § = O ||&# [RZ_T2H_CRS2 0 _primary] FSP Configuration X emimln 0= Outline X =0 &
e
~ [ RZ_T2H_CA55_0_dual 0 Th tive editor that id oy
G - ere is no active editor that provides
&) Includes Y Generate Project Content | an outline.
B src
& configuration xml Project Summary RenEsAs ial
RZ_T2H_CA55_0_dual Debug_Flatjlink i i
% RZ_T2H_CASS. 0. dual Debug Flatlaunch Baa‘rd. RZT2H Evaluation Board (RAM execution without flash memary)
e Device: RIADSGOTTM44GBG
?) Developer Assistance Core: CR52 CPUO
+ ¢S RZ_T2H_CRS2_0_primary [Debuc ore:
e -O-primany Toolchain: GCC for Renesas RZ
nl!' Includes Toolchai
8 sre Versm" 12.2.1.arm-12-24
12 configuration.am! FSP Version:  2.2.0

RZ_T2H_CRS2_0_primary Debug Flatjink || Project Type:  Flat

¥ RZ_T2HCRS2.0 primary Debug Flatlaunc | Location: Ci/1_Prog/Work/Work_C/Work_E2S_RZ...release_chk/RZ_T2H_CRS2_0_primary <
(7) Developer Assistance

Selected software components

Board Support Package Common Files v2.2.0
Memory Config Checking v2.2.0
O Port v22.0 hd

Q=0

Summary | BSP| Clocks| Pins | Interrupts | Event Links | Stacks Components

I Problems % | B Console [T Properties | @ Smart Browser [} Smart Manual § =0
0 errors, 24 warnings, 0 others
Description Resource Path Location Type

&) Warnings (24 items)

< >

{8 configurationxml - RZ T2H_CR52_0_primary

7 Select RZ_T2H_CR52_primary project in the Project Explorer pane and execute [Run] menu -> [Build
Project].
The file Debug\RZ_T2H_CR52_0_ primary.sbd is generated.

8 Double-click the configuration.xml of the RZ_T2H_CA55_0_dual project in the Project Explorer pane
of e? studio to open it. (RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this
configuration file. Please build the primary project in advance.)

R11AN0990EJ0200 Rev.2.00 Page 16 of 19



RZ/T2H Group Dual Encoder sample program

9 Click Generate Project Content in the FSP Configuration pane of e2 studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated in the RZ_T2H_CA55 0_dual project.

) Dual_CASS release_chk - RZ_T2H_CAS5_0_dual/configuration.xml - & studio - [m] s ‘
File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help
R~ wifg v Qv Q E|EocH+
(1 Project Explorer X B ¢ § = O || [RZ.12H CR52 0_primary] FSP Configuration | &} [RZ_T2H_CAS5_0 duall FSP Configy iy | 5= Outline X =0O|s
¥ 5 RZ_T2H_CASS 0 _dual Summary o There is no active editor that provides | €
@l Includes Generate Project Content ' an outline.
3 src
i configuration.xml Project Summary RENESAS =]
RZ_T2H_CA55_0_dual Debug_Flatjlink
% RZ T2H_CAS5.0 dual Debug Flatlaunch Baa-rd: RZT2H Evaluation Board (RAM execution without flash memory)
3 Device: ROADSGO7T7M44GBG
2) Developer Assistance P CAS5 Cored
v 5 RZ_T2H CR52_0, ore: ore
Uﬁ,'g - ’95 primary Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
inari
Toolchain
& Includes Version: 10.3.1.20210621
& 2t FSP Version:  2.2.0
&zt gen Project Type:  Flat
B sre Location: C:/1_Prog/Work/MWork_C/Wark_E2S_RZ...55_release_chk/RZ_T2H_CAS55_0_dual |
& Debug
= rzt_cfg Selected software components
& script
# configuration.xml Board Support Package Common Files v2.2.0
RZ_T2H_CR52_0_primary Debug_Flat jlink Memory Config Checking v2.20 v
¥) RZ_T2H_CR52_0_primary Debug_Flatlaunc VO Port v22.0
) Developer Assistance =
DIE
Support il =
Summary | BSP| Clocks| Pins | Interrupts Event Links Stacks Components
[#] Problems [ Consale [T Properties| @ Smart Browser K} Smart Manual ® | CH &l xRH B2 -r=0
CDT Build Console [RZ_T2H_CAS55_0_dual]
< >

10 Select [Project] menu -> [Build All]
The Debug\RZ_T2H_CA55_0_dual.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure”, connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the
RZ_T2H_CR52_0_primary project.

Click [Debug] to start downloading to internal RAM.
2 Click [Run] menu -> [Resume] to run the CA55 start-up program.

3 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the
RZ_T2H_CA55_0_dual project.

4 Select 'No' when the dialog box inquiring about termination of the active debug session is displayed.
& Launcher X

l A Renesas GDB debug session is already active.

Do you want to terminate all currently active debug sessions before starting the new
session? (Note: Selecting No may result in unstable debug functionality)

Yes | | No Cancel

5 If 'Proceed with launch' is displayed, select 'Yes'.
6 Click [Debug] to start downloading to internal RAM.
7 Click [Run] menu -> [Resume] to run the sample program.

[[]Remember my decision
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(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.15.10 console commands in the RZ/T2H Group Dual Encoder Sample Program Application Note.

V| COMG - Tera Term VT — O X

File Edit Setup Control Window Help
g start
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

- A-format is a trademark of Nikon Corporation.

- EnDat is a registered trademark of Dr.Johannes Heidenhain GmbH.

- IAR Embedded Workbench is a registered trademark of IAR Systems.

- Arm is registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere. All rights
reserved.

- Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners. a trademark or a registered trademark which belongs
to the respective owners.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2025 Renesas Electronics Corporation. All rights reserved.


https://www.renesas.com/
https://www.renesas.com/contact/

	1. Package Contents
	1.1 Software
	1.2 Documents

	2. File Structure
	3. About Dual Encoder Sample Program
	3.1 Software Information
	3.1.1 Base OS
	3.1.2 Memory Size

	3.2 Hardware Information
	3.2.1 Device
	3.2.2 Target Board

	3.3 Procedures on Development Environments: CR52 ver.
	3.3.1 Preparation before Executing the Sample Program
	3.3.2 EWARM from IAR Systems
	3.3.3 e2 studio from RENESAS

	3.4 Procedures on Development Environments: CA55 ver.
	3.4.1 Preparation before Executing the Sample Program
	3.4.2 EWARM from IAR Systems
	3.4.3 e2 studio from RENESAS



